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Chapter 1

Setup and Installation
This manual will help you get started quickly with OmniPage Limited 
Edition, your OCR software. 

Optical character recognition (OCR) is the process of turning an image, 
such as a scanned-paper document or an electronic fax file, into 
computer-editable text so you do not have to type the text.

Choose Help in the OmniPage Limited Edition menubar for additional 
information.

Before you install OmniPage Limited Edition, please test your scanner to 
make sure it’s running correctly with your computer system using the 
manufacturer’s scanning utility or imaging software.
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Minimum System Requirements
Generally, you’ll need the following to run OmniPage Limited Edition:

• Computer with an 80386 or higher processor
• Microsoft Windows version 3.1 or higher running in Enhanced 

mode, Windows 95, or Windows NT 3.5.1 or 4.0.
• Windows-compatible mouse
• VGA 640x480, 16 colors 
• 6MB available hard disk space (more for multilingual versions)

Windows 3.1 Additional Requirements
• 8MB RAM
• MS-DOS 5.0 or higher
• 10MB swap file for U.S. version or 12MB swap file for the non-

U.S. version

Windows 95 Additional Requirements
• 8MB RAM
• MS-DOS 5.0 or higher
• 6MB swap file for U.S. version or 8MB swap file for the non-U.S. 

version. Caere recommends that you allow Windows 95 to 
manage your virtual memory.

Windows NT Additional Requirements

• 12MB RAM

• 6MB swap file for U.S. version or 8MB swap file for the non-U.S. 
version. 

Memory
OCR is memory intensive; the system requirements above are 
minimums. The more RAM your system has, the better. In addition, you 
must have enough free-disk space for temporary files. Dense, complex 
pages require more disk space. 

Setting up a large, permanent swap file (virtual memory) can speed text 
recognition. See “How to Create a Windows 3.1 Swap (Virtual Memory) 
File” on page 6 for instructions on how to set up virtual memory.

If you received your OmniPage Limited Edition as bundled software 
with a scanner, the OmniPage Limited Edition installation files may be 
included on the scanner software DC-ROM.
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Software Installation (for Windows 3.1, NT, and 95)

If you received your software on a scanner CD-ROM, you may have 
already installed OmniPage Limited Edition. Follow the procedure 
below if you received diskettes. 

To install from disks, run the SETUP program on disk #1 as follows:

1 Start Windows.

2 Exit any open applications.

3 In Windows 3.1x or NT 3.5.x, open the Program Manager.

4 Insert OmniPage Limited Edition disk #1 in drive D� (or E�) of 
your computer.

5 Choose Run... from the File menu of Windows 3.1 or NT 3.5, or 
from the Taskbar Start button of Windows 95 or NT 4.0.
The Run dialog appears.

6 Type D�?VHWXS (or E�?VHWXS) in the Command Line edit box 
and click OK.
With some versions, the OmniPage Limited Edition Product 
Registration dialog appears during installation. It provides a 
number to call so you can receive and then enter a registration 
code in the dialog.

7 Click OK in the OmniPage Limited Edition Product 
Registration dialog if you entered a number in the Registration 
Number text box. Otherwise, click Cancel to continue 
installation.

8 Select your word-processing software when prompted and 
click Continue.
This choice will be set up automatically to work with 
OmniPage Limited Edition’s direct input (OCR Aware) feature. 

Insert the other installation disks and follow instructions in the various 
dialogs as prompted.

To install from a Caere-labeled OmniPage Limited Edition CD-ROM:

1 Type x:\Disk1\setup.exe  on the command line, 
where x : is your CD drive.

2 Press Return.
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How to Create a Windows 3.1 Swap (Virtual Memory) File 
To run OmniPage Limited Edition, it helps to have 8-12MB of free disk 
space set up as a Windows swap file (virtual memory). For best 
performance, use a Permanent rather than a Temporary swap file. 

The swap file acts as virtual memory disk space that is used as if it were 
volatile memory (RAM). Information is stored temporarily on disk 
rather than using RAM. This allows you to run more programs than you 
could with RAM alone. However, using virtual memory is slower.

For more information about virtual memory, see the Windows User’s 
Guide. For more information about the Windows swap file, or if you 
have any difficulty creating a swap file, see the chapter “Optimizing 
Windows” in the Windows User’s Guide.

To create an 8MB Windows swap file:

1 Close any open applications.

2 Double-click the Control Panel icon in the Main window of the 
Program Manager.

3 Double-click the 386 Enhanced icon to display the 386 
Enhanced dialog.

4 Click Virtual Memory... to display the Virtual Memory dialog.

5 Check the entry after Size.

• A swap file equal to or larger than 8192 is sufficient. Click Can-
cel to return to the 386 Enhanced dialog and click Cancel again. 
Close the Control Panels.

• A swap file that is smaller than 8192KB must be changed. 
Proceed to step 6.

6 Click Change>> to expand the dialog.

7 Select a new drive in the Drive drop-down list if you want the 
swap file to be somewhere other than on the default drive. 

If you cannot find a drive with 8192KB of contiguous free 
space, you need to delete files to free up space or “defragment” 
the disk by using the DOS GHIUDJ command.

8 Type at least ���� in the New Size edit box.

9 Click OK and exit the Control Panels.

10 Click Yes in the dialog that asks if you are sure you want to 
make changes.

11 Click Restart Windows. Do not press Ctrl-Alt-Del to restart.
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Installation Troubleshooting
There are conditions that you can easily remedy in which OmniPage 
Limited Edition may stop functioning. Refer to “Installation Checklist” 
on page 24

Getting the Latest Information
There may have been minor changes in a feature or procedure between 
the time this manual was printed and the time the program was 
finished. If there are any such changes, they are explained in a file called 
README.TXT located in the directory where you installed OmniPage 
Limited Edition. To view this file, open Windows File Manager, locate 
the file, and double-click on it.       
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Chapter 2

Acquiring Scanned Text
into Your Word Processor

You can scan and recognize text without leaving your word processing 
or spreadsheet application. Once you register an application as OCR 
Aware, the Acquire Text... command will be enabled and appear in your 
application’s File menu. 

You can then initiate scanning while in that application.

Register an Application as Being OCR Aware
1 Launch OmniPage Limited Edition if it is not open already.

2 Launch any applications in which you want to add the Acquire 
Text... command.

3 Choose OCR Aware... in the OmniPage Limited Edition Tools 
menu.

Current applications appear in the left list. The word processor 
you chose during installation appears in the right list.

4 Select an application name in the Unregistered Applications list 
box on the left.

5 Click the green arrow. 

6 Click OK when you are finished.
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Use Direct Input
1 Launch a registered application.

2 Click to place the cursor where you want scanned and 
recognized text to appear in your document.

3 Choose Acquire Text... in the first (usually the File) menu.
OmniPage Limited Edition will let you scan and OCR text. The 
text will then appear in your open application beginning at the 
point you placed the cursor. 

Open File Dialog

If your scanner is not turned on or connected, or OmniPage Limited 
Edition does not support scanning with your scanner, an Open File 
dialog appears. 

From this dialog, you can import a previously scanned file, such as a .tif 
or .bmp file.
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Chapter 3

Scaning Text Directly from
OmniPage Limited Edition

This section guides you through the basic steps of using OmniPage 
Limited Edition to scan and recognize text. See “Acquiring Scanned Text 
into Your Word Processor” on page 8 for information on using 
OmniPage Limited Edition from within other applications.

There are three basic steps:

• Click the Acquire Image button to scan a page.

• Click the OCR button to recognize text on the page.

• Click the Save As button to save the recognized text in your word 
processor’s file format.

Scan a Page
1 Double-click the OmniPage Limited Edition icon in the Caere 

Applications program group.
The program launches and the OmniPage Limited Edition 
main window appears.

Menus

Toolbar

Tool Tip
(Hold the cursor 
over a button in 
the toolbar.)

Status text
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2 Multilingual versions offer several recognition language and 
user-interface language choices. Choose Language... in the Tools 
menu to open the Language dialog.

3 Place a page in the loading tray of your scanner.
Make sure it is aligned correctly.

Choose a high-quality, laser-printed page similar to a business letter.

4 Click the Acquire Image button in the toolbar or choose Acquire 
Image in the File menu.
Scanning starts automatically if you placed a page in an 
automatic document feeder. Otherwise, the Load Scanner 
dialog appears.

5 Click Scan if this dialog appears.

6 Click OK to continue.

Open File Dialog

If your scanner is not turned on or connected, or OmniPage Limited 
Edition does not support scanning with your scanner, an Open File 
dialog appears. From this dialog, you can import a previously scanned 
file, such as a .tif or .bmp file.
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OmniPage Limited Edition scans the page and displays it in the 
preview area.

Zones and Zoning Techniques
OmniPage Limited Edition automatically draws a single zone around 
the entire page area. You might want to select a new zone or resize the 
existing zone to omit unwanted information or graphics.

• To resize the zone, drag any of the four side handles. You can 
resize the zone vertically and horizontally of the zone box. When 
you resize a zone, your cursor will change to a plus sign with 
“abc” in the lower right quadrant. You can also drag any corner-
zone handle to simultaneously change the zone’s vertical and 
horizontal dimensions.

• To adjust the size of your acquired image, select the pull-down 
menu in the toolbar. You can view the image at various 
magnifications. Or, you can select Zoom in the View menu. 

• To move the zone, place your cursor inside the zone. The cursor 
will change to a four-way arrow. Click and drag the zone, which 
will keep its size, to a new location.

• To delete the zone, press the Del key.
• To draw a new zone, point your “abc” cursor at one corner of a 

new intended zone, and click and drag a box around the area you 
want to recognize.

• To rotate a zone in 90-degree increments clockwise or counter-
clockwise, click the Rotate button and press the left-mouse button 
for counterclockwise rotation or the right-mouse button for 
clockwise rotation. 

abc

abc
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Text Settings
Text settings affect how the text will be processed. To see or change the 
text settings, choose Text Settings from the Settings menu. The Text 
Settings menu dialog appears. See the detailed information on 19.

With the Text Settings dialog, you can specify that suspicious words or 
characters are to be marked, and can select a marking character. 

Your application must be registered as being OCR aware before this 
feature works. See “Registering an Application as Being OCR Aware” 
on 8.

Use Scanner Settings
Choose Scanner Settings... in the OmniPage Limited Edition Settings 
menu to fine tune your scanner for your image. Be sure that Scan 
Resolution is set to 300 d.p.i., and try adjusting Brightness manually if you 
do not get acceptable results.

Auto Thresholding
Auto Thresholding is available with some scanning solutions. Auto 
Thresholding technology improves OmniPage Limited Edition’s 
recognition by improving the quality of the image that comes from your 
scanner. Auto Thresholding technology provides automatic-image 
enhancement that can increase the accuracy of recognition, particularly 
on degraded pages.

Auto Thresholding technology can help enhance the characters to 
provide a better image and more accurate OCR results. For example, 
Auto Thresholding can help eliminate the background “noise” often 
found when text is printed on a colored or dark background. Now you 
can scan a wider variety of documents and get more usable results.
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Using Auto Thresholding

Auto thresholding is controlled by the Brightness control in the Scanner 
Settings window.

To enable Auto Thresholding, click the button to the left of the 
brightness scroll bar (“Auto” appears to the right of the scroll bar). To 
disable Auto Thresholding, click the icon again (a brightness percentage 
or text appears to the right of the scroll bar).

Recognizing the Text
Click the OCR button in the toolbar or choose OCR in the File menu.

OmniPage recognizes the document’s text. The Progress Monitor 
window displays the process.

After OCR a dialog allows you to scan more pages or to finish. 

Auto Threshold button
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Saving the Text
After you finish scanning, the Save As dialog appears. If it does not 
appear, click the Save As button or choose Save as Document... in the File 
menu.

1 Enter a name for your job in the File Name text box.

2 Choose a new location for the saved file if you wish.

3 Select a file type for the word-processing format you normally 
use in the drop-down list at the bottom.

4 Click OK. 
OmniPage Limited Edition saves the text file as directed. You 
can now edit the text in your word processor or spreadsheet.
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Chapter 4

Scanning Tips
This section explains how to achieve the best recognition accuracy 
possible. See the online Help for more detailed information.

Improving OCR Accuracy
OCR accuracy depends on the quality of the scanned image. You’ll have 
very few errors if you scan sharp, laser-printed documents. Scanning 
faxes, dot matrix documents, and poorly printed pages may produce 
unacceptable results.

Consider the following when you scan a page:

• The print should be reasonably clean and crisp. 

• The document should be free of notes, lines, or doodles; anything 
that is not a printed character will slow OmniPage Limited 
Edition considerably.

• The document font must be non-stylized; for example, the Zapf 
Chancery font is too fancy for OmniPage Limited Edition.

• It's hard to recognize underlined text accurately; the underline 
changes the shape of descenders on the letters q, g, y, p, and j.

• The scanner glass must be clean. 

If you scan a foreign-language document and you get many OCR errors, 
check that the document’s language is selected as the Recognition 
Language in the Tools menu/Language dialog. 

If there is no listing for the language, upgrade to OmniPage Pro, which 
recognizes 13 language-character sets.
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Chapter 5

Command Reference

This section describes all OmniPage Limited Edition menu commands. 
Many menu commands have corresponding shortcut buttons in the 
toolbars.

Help Menu
Online procedures are thoroughly explained for using all OmniPage 
Limited Edition features. You can access Help by clicking a Help button 
in a dialog, by choosing Help in the OmniPage Limited Edition menubar, 
or by clicking the Help button in the toolbar and then clicking on a 
toolbar button. 

File Menu

New Job 

Choose New Job to start a new job by scanning a page. The New Job 
button provides much of the same functionality as the Acquire Image 
button; however, the New Job button starts a new job (discarding 
previously scanned pages), while the Acquire Image button adds 
scanned pages to the existing job.

Save as Document

Choose Save as Document to open the Save As dialog so you can save the 
text from OCR’d files. See “Saving the Text” on page 15. 

Acquire Image

Choose Acquire Image to scan pages and bring them into the Preview 
area. The Acquire Image command provides much of the same 
functionality as the New Job command. The Acquire Image command 
starts a new job at the beginning of a new session; however, it adds 
pages to the existing job, while the New Job command always starts a 
new job. See “Zones and Zoning Techniques” 12.
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If your scanner is not turned on or connected, or OmniPage Limited 
Edition does not support scanning with your scanner, an Open File 
dialog appears. From this dialog, you can import a previously scanned 
file, such as a .tif or .bmp file.

OCR

Choose OCR to process the current page or pages in the job. After text 
recognition takes place, the Save As dialog will appear if Auto Save is 
selected in the Settings menu. Otherwise, choose Save as Document in the 
File menu after OCR takes place.

Print 

Choose Print to print the page appearing in the Preview area using the 
default Windows Print Setup settings. 

Exit

Choose Exit to leave the OmniPage Limited Edition program. You’ll be 
prompted to save any work that was scanned but not saved.

Edit Menu

Copy 

Choose Copy to copy an entire page or selected zone into the Clipboard 
and then paste it into other applications. When you copy, text from the 
selected zones is recognized and pasted rather than the image itself.

Paste

Choose Paste to paste an image that was copied from another Windows 
application. The image is copied from the Clipboard to the Preview area.

Clear

Choose Clear to eliminate a selected zone from the preview image. 

Select All

Choose Select All to select a previously described zone.
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View Menu

Rotate

The Rotate menu item lets you rotate the page in the Preview area 
clockwise 90, 180, or 270 degrees. The Rotate button allows you to rotate 
the page in 90-degree increments, clockwise using the left-mouse button 
or counter-clockwise using the right-mouse button.         

Zoom

When you select Zoom in the View menu, a pull-down menu appears 
where you can view the page in the Preview area at various 
magnifications.         

Tools Menu

Language

Choose Language to display the Language dialog, where you can change 
the language used for OmniPage Limited Edition's menus, dialogs, and 
other messages and choose another recognition language. (These 
options are not available in all versions of OmniPage Limited Edition.)

OCR Aware

Choose OCR Aware (direct input) to set up one or more Windows 
applications for use with OmniPage Limited Edition. OmniPage 
Limited Edition displays the OCR Aware dialog, which you use to add 
new applications or delete existing applications from the list of those 
registered. See “Acquiring Scanned Text into Your Word Processor” on 
page 8.

Settings Menu

Text Settings

Text settings affect how text is processed in OmniPage Limited Edition. 
To see or change text settings, choose Text Settings from the Settings 
menu. The Text Settings dialog appears.     
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Mark Suspicious Words

When enabled (X in the box), uncertain words are marked for proofing 
in the word processing format of your choice when you save your 
document.

Mark Suspicious Characters

When enabled (X in the box), uncertain characters are marked for 
proofing in the word processing format of your choice when you save 
your document.      

Mark Suspicious Characters or Mark Suspicious Words must be enabled 
in the Text Settings dialog (X in the boxes) before you OCR. 

Save Markers As

During recognition, OmniPage Limited Edition keeps track of all 
characters and words for which recognition was uncertain. You have the 
option of marking these uncertain characters and words in your finished 
document and specifying the character to use as a marker. If you want 
your finished document to contain markers, enable Save Markers As (X 
in the box) and type the desired marker character in the box. You should 
specify a character that is used infrequently so that you can use your 
word processor’s search function to quickly find all markers.      

Auto OCR

OmniPage Limited Edition can be set to automatically start OCR after a 
page is scanned by enabling Auto OCR in the Settings menu. Auto OCR 
uses the current settings and zones. You can also enable Auto OCR on a 
case-by-case basis by clicking on the New Job or Acquire Image button 
with the right mouse button.      

Auto Save

You can choose to be prompted to save your documents after processing 
has completed. When Auto Save is enabled (a check mark appears next 
to it), the Save As dialog appears automatically after processing.     
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Scanner Settings

 Scanner settings affect how pages are scanned, and thus can affect text 
recognition. To change scanner settings, choose Scanner Settings from 
the Settings menu. 

 Click on the Auto-Threshold button (left of the Brightness slider bar) to 
enable automatic brightness; the word or percentage next to the 
brightness scroll bar will change to Auto. 

Image Type

Binary images include line art that are typically black lines on a white 
background. Choose Binary for scanning pages with text and line art. 

If your scanner supports dithering, you can choose Dithered for scanning 
pages of mixed half-tone images and text. A dithered pattern is an 
arrangement of black-and-white dots that simulates a half-tone. 
Different dither patterns produce extremely different results, and it is 
generally much coarser than a half-tone due to the limitation of scanning 
and printing at 300 dots-per-inch.

Page Size
Choose the input size of the page you are scanning. Select Letter to scan 
8 1/2” x 11” pages, Legal to scan 8 1/2” x 14” pages, or A4 to scan 21cm 
x 29.7cm pages. 

Brightness
The brightness scroll bar lets you lighten and darken pages to 
compensate for less-than perfect originals. You must adjust the 
brightness setting before scanning a page. Changing this setting does 
not affect a page that has already been scanned.        
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Changing the brightness has the same effect as on a photocopier. Choose 
darken when scanning light pages, and choose lighten when scanning 
dark pages.

Your scanner has preset “darker” and “lighter” settings, which are 
accessed by clicking to the right or left of the center gauge; the display 
will change to the words Darker or Lighter, accordingly. Click on the left 
or right arrow buttons to set dark and light percentages. 

Contrast
Contrast does not affect the quality of recognition. Change the Contrast 
setting to improve the quality of images you capture. The Contrast 
setting is disabled when Auto-Threshold is enabled, and it is 
recommended that you use Auto-Threshold for OCR.       

Scan Resolution
Choose the desired scan resolution from the drop-down list box. 
Generally, you want to use 300 dots-per-inch (dpi) when processing 
text. You can use a higher dpi setting for special recognition situations 
or for capturing graphics.       

Register/Upgrade
Choose Register to register your copy of OmniPage Limited Edition. 
After you register, the menu command will change to Upgrade. Phone 
numbers for your location are provided in the Register dialog list.

Choose Upgrade to upgrade to OmniPage Pro, Caere’s most-advanced, 
full-featured OCR program. Registered users can buy OmniPage Pro for 
a special, low price. Phone numbers for your location are provided in the 
Upgrade dialog list.
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Chapter 6

Troubleshooting and
Support

Overview
Use this chapter for any of the following reasons: 

• You could not complete installation because the installation 
program had problems with your system configuration. 

• You just finished installing OmniPage Limited Edition and it 
does not work.

• OmniPage Limited Edition was working correctly but suddenly 
stopped working.

• System performance is not acceptable. 

Throughout this section, the directory F�?RSOLPLW refers to the default 
directory in which you installed OmniPage Limited Edition. If you 
installed OmniPage Limited Edition in a different directory or on a 
different disk drive, substitute the appropriate information when 
necessary.
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Installation Checklist
Use this checklist to find and remedy the most common installation 
problems when using Windows 3.1 or Windows 95.     

• Make sure your PC starts normally (without any error messages) 
and can run other software.      

• Make sure Windows 95 or Windows 3.1 is installed and 
working correctly. Windows 3.1 should be operating in its 
Enhanced mode. Try running other Windows software such as 
Paintbrush, Notepad, or Calculator to see if they run properly.   

• Be sure to reboot your computer after installing Windows so 
that the Windows subdirectory is added to your path. If the 
OmniPage Limited Edition installation program cannot find your 
Windows subdirectory in the path, the installation program may 
terminate. 

• Make sure your system has at least 8MB of free RAM for 
OmniPage Limited Edition. More may be needed if you want to 
load other programs at the same time or use OCR Aware. 

• Make sure your scanner is plugged in, turned on, and that it is 
working according to the specifications. If you have not done 
that, it is important to do so now, before continuing with 
troubleshooting. If you have another software package that uses 
your scanner, use it to see whether the problem is specific to 
OmniPage Limited Edition or common to other programs.

• If you are using a disk cache program (other than the 
VPDUWGUY�H[H program included with Windows 3.1), 
temporarily disable it and try to install again. Some cache 
programs interfere with proper memory allocation. 
Once you complete the installation, re-enable the cache program 
and make sure it works. You should never run Windows 
without a disk cache program — performance will not be 
acceptable. In most cases, you will want to use VPDUWGUY�H[H. 

• Windows 3.1 From the Windows Program Manager, choose 
About Program Manager from the Help menu to determine the 
mode in which Windows is operating and the amount of 
available memory. Windows should be running in Enhanced 
mode and report at least 6 MB (9 MB preferred) of free memory. 
Consult the Windows installation and the configuration 
information.

• Windows 95: Double-click the “My Computer” icon and choose 
About Windows 95 under the Help menu to see the amount of 
memory and system resources you have.
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If OmniPage Limited Edition has Stopped Working
If OmniPage Limited Edition worked at one time, but suddenly stopped 
working, you may have inadvertently altered your system 
configuration. Review the following questions to help pinpoint the 
problem. If this does not help, try reinstalling OmniPage Limited 
Edition before calling for help. 

• Is your scanner plugged in, turned on, and securely connected 
to your interface card? 
This can cause errors when launching or running OmniPage 
Limited Edition. Can you run your scanner with any other 
software package?     

• Have you installed cards in your computer that might interfere 
with the memory addresses being used for your scanner card?     
You may need to reconfigure the new cards to use other memory 
addresses, DMA channels, or interrupts.

• Did your scanner have a paper jam?
Clear the paper jam, turn the scanner off and then back on, and 
then reboot your system.   

• Are the OmniPage Limited Edition program files or the disks 
that they are on corrupted? 
Run the DOS FKNGVN program to find out.     

• Have you run out of disk space for saving your documents? 
If you have been scanning images, you can run out of disk space.

• Did you reinstall Windows? 
If you reinstalled Windows, you must save the OmniPage 
Limited Edition RSOLPLW�LQL file before deleting the Windows 
directory. 

• Are you receiving the following error message?
“Can’t create a default page directory.”

• Create a directory under the OmniPage Limited Edition directory 
called WHPS, and then restart OmniPage Limited Edition.

• Are you receiving one of the following error messages?
“Can’t launch RSP or couldn’t find it after launch.”
“Zone list full.”
“Not enough memory to load executable.”
“General Protection Fault in XOCR.”
These can be related to virtual memory size. Be sure you have at 
least 9 MB of virtual memory.
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Possible Remedies for Users of Windows 3.1
• Have the system configuration files (DXWRH[HF�EDW and 
FRQILJ�V\V) been modified recently? 
Installing a new application program may have modified these 
files in such a way that they will no longer work with OmniPage 
Limited Edition. (To determine the last time they were modified, 
check the date and time displayed by the DOS GLU command.)    

• Did you recently install a new Windows 3.1 application? 
If so, it may have changed the EMMSize parameter in the 
V\VWHP�LQL file. For proper operation, the EMMSize parameter 
should be left blank: (006L]H�  

• Have you installed memory-resident application programs that 
take up too much memory or conflict with Windows operation? 
Or, have you loaded other Windows programs that are leaving 
too little memory free for proper operation of Windows and 
OmniPage Limited Edition? 

• From the Windows 3.1 Program Manager, choose About Program 
Manager from the Help menu to determine the mode in which 
Windows is operating and the amount of available memory. 
Windows 3.1 should be running in Enhanced mode and report at 
least 9 MB of total free memory. Consult the installation and 
configuration information included with Windows to determine 
how to correct any problems.

Choose About Program Manager from the Windows Program 
Manager Help menu to check the amount of free memory.

Check the virtual memory size within the Windows Control 
Panels and make sure there is at least 9 MB.

Possible Remedies for Users of Windows NT
• Did you attempt to install OmniPage Limited Edition while 

operating at the User group level? 

If you are in an organization that has a MIS (network and 
technical services department), ask them to install OmniPage 
Limited Edition at the Admin user level. OmniPage Limited 
Edition will not install at the User group level, which is an 
intentional safeguard of Windows NT.



If OmniPage Limited Edition Performance is Unacceptable

  Troubleshooting and Support - 27

• Have the system configuration files (DXWRH[HF�EDW and 
FRQILJ�V\V) been modified recently? 
Installing a new application program may have modified these 
files in such a way that they will no longer work with OmniPage 
Limited Edition. To determine the last time they were modified, 
check the date and time displayed by the DOS GLU command. 

• Did you recently install a new Windows 3.1 application? 
If so, it may have changed the EMMSize parameter in the 
V\VWHP�LQL file. For proper operation, the EMMSize parameter 
should be left blank: (006L]H�  

• Have you loaded other Windows NT programs that are leaving 
not enough memory free for proper operation of OmniPage 
Limited Edition? 
Within the System Settings in the Control Panel, check the 
amount of free memory (RAM). Under Performance, increase 
the default amount of memory or allocate more disk space.
Check the virtual memory size within the Windows Control 
Panels and make sure there is at least 9 MB.

• Check the disk space used on the volume that has Windows NT 
installed. If your volume is close to being full, you will have 
difficulties. Free some space.

If OmniPage Limited Edition Performance is Unacceptable
There are many different areas that can affect the performance of 
OmniPage Limited Edition and other programs. Check the following: 

• If performance (or accuracy) is not acceptable, adjust the 
brightness setting and try again. With some scanners, depending 
on the quality of your original document, the wrong setting can 
result in very slow recognition. 

• Recognition performance varies with the quality, point size, 
font, and density of the original document. A page of 8 point 
type with 6,000 characters will take much longer to recognize 
than a page of 12 point type with 2,000 characters. Also, pages 
with complex formats require more recognition time than simple, 
single-column pages. 

• Make sure there is sufficient disk space for the temporary files 
that Windows and OmniPage Limited Edition must create. For 
best performance, your disk should have at least 25% of its space 
free. If it has less space than this, files may be fragmented (that is, 
written in small blocks in many different places on your disk). 
This results in very slow performance.      
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• Optimize your disk regularly. When you start with a new hard 
disk, all the data in one file is stored in contiguous blocks from 
beginning to end. As you (and your programs) create, modify, 
and delete files, DOS uses whatever space is available on your 
disk. This means that small portions of files are stored in blocks 
all over the disk; the disk becomes “fragmented.” Instead of the 
disk quickly reading the entire file in one operation, it must 
search for all the individual blocks. 
An optimization program reorganizes your disk and puts all 
blocks of each file into a contiguous space. Programs that do this 
are available from your computer dealer and should be run 
regularly. 

• Check for a computer virus. Computer viruses corrupt your 
system when you install software from infected diskettes or 
download infected programs from modems. They can even get 
into your system over a network connection. A virus can not only 
slow down your system it can also damage your programs and 
data. You should regularly check your system for viruses.      
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Product Support
Product support is available if you need help. However, please check the 
table of contents in this manual to find the information you need — you 
may be able to save a phone call.

Services

Product support and information are available through the services 
listed on the separate Product Support sheet, which is included. We 
suggest that you save the Product Support sheet for future reference.

You can also find help at the Caere Corporation Internet site. Visit:

http://www.caere.com/

Seek the “Support” pages.

Information We Will Need From You

For the most efficient response, please have the following information 
ready and be near your computer when you call:

• OmniPage Limited Edition serial number (printed on your 
program disks).

• OmniPage Limited Edition version number.

• DOS operating system version.

• Scanner manufacturer and model.

• If you have a TWAIN-compliant scanner, the name and revision 
level of your TWAIN software.

• The amount of RAM in your system.

• The amount of free conventional memory available.

• A listing of the DXWRH[HF�EDW file.

• A listing of the FRQILJ�V\V file.

• The size and location of your Windows 3.1 swap file.

• The make and model of your computer system and peripheral 
devices (printers, monitors, etc.).

• The text of any error message you received.

• Details about what you were doing when the error occurred.
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Chapter 7

Upgrade to OmniPage Pro
Our top-of-the-line OCR package provides advanced features that make 
page recognition faster, easier, and more accurate. The features include:

• The Language Analyst, Caere's most-accurate OCR technology, to 
give you a dramatic increase in accuracy and performance.

• Scanning Capability for the widest range of documents: faxes, 
résumés, stacks of double-sided pages, and so on. 

• True Page Recognition lets you save a document's original layout 
and font styles.

• AutoOCR Toolbar runs OCR with a single click and follows your 
progress.

• Recognition of 13 Language-character sets. You can even 
recognize multilingual documents.

• Drag and Drop capabilities

• Zone Templates allow faster and more accurate recognition of 
similar document formats.

• Verification Window shows suspect words for quick proofreading.

• Multiple Zones let you create up to 64 regions and specify (or 
reorder) only the text you want to OCR.

• Deferred Processing lets you save time by scheduling OCR.

• Performs as a 32-bit, native Windows 95 application and uses 
Microsoft’s interface conventions.

• OCR Training for hard-to-read characters.

• OCR Wizard, context-sensitive help, Hoover Help, and Tool Tips.

Registered OmniPage Limited Edition users can upgrade to OmniPage 
Pro at a special low price. 

In the US and Canada, call (800) 224-0660. (In the UK, call 0800-614-759) to 
order your copy or for more information. Outside the US/UK, please 
choose the Register/Upgrade menu for a list of local phone numbers.


